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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published May 2015. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 
Welcome to Deltek Open Plan 3.5 Release Notes. These release notes contain a summary of the 
following: 

 Pre-Installation Information 

 Major New Features 

 Enhancements 

 Software Issues Resolved 

 Database Changes 
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Pre-Installation Information 
Before you begin the installation of Open Plan 3.5, it is important to understand the information 
discussed in this section. 

 Open Plan is compatible with the following IPM products: 

 Deltek WelcomHomeTM  5.0 

 Deltek CobraTM 5.1.2, 5.1.3 

 Deltek PM Compass 2.2 (PMC 2.2 is planned for release later this year. Check the 
compatibility when it is released) 

 Deltek Acumen Suite 5.1, 6.0 (Fuse, Risk, and 360) 

 

Open Plan users who are integrating data with these products must ensure that the 
products are upgraded to the compatible versions. 

 The following software requirements (Database Tier) have been tested for compatibility 
and are fully supported by Open Plan: 

 Operating System 

 Windows Server 2012 R2 

 Windows Server 2012 

 Windows Server 2008 R2 

 Windows Server 2008 

 Database Platform 

 Oracle 12c R1, 11g R2 

 Microsoft SQL Server 2014, 2012, 2008 R2 

 Microsoft Access (with the Microsoft Jet 3.51 or 4.0 OLE DB Provider) 

 The following software requirements (Client Tier) have been tested for compatibility and 
are fully supported by Open Plan: 

 Operating System 

 Windows 8.1 

 Windows 8 

 Windows 7 

 Windows Terminal Services/Citrix 

 Windows Server 2012 R2 

 Windows Server 2012 

 Windows Server 2008 R2 

 Windows Server 2008 

 Integration Products (Optional)  

 Microsoft Project® 2013, 2010, 2007 
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Custom Programming 
Before you upgrade to Open Plan 3.5: 

 Review all existing custom work at least eight weeks prior to your intended go-live date. 

 Compare your custom work to the new functionality being provided in this release. 

 If this new version possesses the functionality contained in your custom work, these 
custom programs may no longer be needed. If the functionality contained in your custom 
work is not provided in this release, you must ensure the custom work remain intact 
through the upgrade process. 

 Identify any hot fixes or patches that you plan to deploy with your Open Plan 3.5 upgrade. 
Ensure that, following the hot fix or patch deployment, you retain all custom functionality. 

 Deltek strongly recommends that when upgrading, you first deploy an instance of Open 
Plan 3.5 in your test environment. This allows for functional UAT (User Acceptance 
Testing) to ensure that all mission critical custom features are still available to the user 
community. Typical deployments call for a 30 – 45 day test period before upgrading into 
your production environment. 

 

Deltek’s Technical Services team is available to support you as you plan for this 
upgrade. We offer both technical and custom services, ensuring the best possible 
Deltek experience. If you would like consulting assistance, contact your Deltek account 
representative. 
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If You Need Assistance 
If you need assistance installing, implementing, or using Open Plan, Deltek makes a wealth of 
information and expertise readily available to you. 

Customer Services 
For over 30 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Find out more about these and other services from the Customer Care Connect site. 

Customer Care Connect Site 
The Deltek Customer Care Connect site is a support Web site for Deltek customers who 
purchase an Ongoing Support Plan (OSP).  

The following are some of the many options that the Customer Care Connect site provides: 

 Search for product documentation, such as release notes, install guides, technical 
information, online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers 
through the Deltek Connect Customer Forums 

 Access Cloud specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 

For more information regarding Deltek Customer Care Connect, refer to the online help available 
from the Web site. 
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Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  
1. Go to http://support.deltek.com.  

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 

 

If you forget your username or password, you can click the Account Assistance button on the 
login screen for help. 

Available Documentation  
Release notes and other guides are available for this release. You can download these 
documents in two ways. 

Deltek Software Manager 
The Documents tab in Deltek Software Manager lists all of the documents associated with a 
release and lets you download the ones that you want. 

To download documents, complete the following steps: 

1. On the Deltek Customer Care site, click the Product Downloads tab, then select Launch 
Deltek Software Manager. 

2. When the Deltek Software Manager opens, highlight a release in the left pane. 

 

Do not enter a check next to the release name or click Add to 
Download Queue. If you do so, you will download the software as 
well as any documentation that you want. 

3. Click the Documents tab to display a list of available documents for the release. 

4. Select the documents that you want. 

5. Chick View Download Queue to see a list of documents that you selected. 

6. Click Download. 

Customer Care Site Enterprise Search 
Use the search feature to find specific documents or to see a list of all documents associated with 
a release. Then open or download the ones that you want. 

To download documents, complete the following steps: 

1. On the Deltek Customer Care site, click Enterprise Search. 

2. Select Release Documentation as the Source. 

3. Perform one of the following actions:  

 To see a list of all available documentation for a release, enter the product and 
release number (for example, Vision 7.4) in the search field. 

 To find a specific document, enter a description of the document (for example, Vision 
7.4 release notes) in the search field. 

http://support.deltek.com/
https://deltek.custhelp.com/app/home
https://deltek.custhelp.com/app/home
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4. Click on the document, and then choose to open or save it. 
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Enhancements 
This section includes summaries of the enhancements made to existing features in this release. 

Microsoft Project Import/Export Improvements 
The following enhancements were made on the Microsoft Project Import and Export feature: 

 Import Enhancements: 
 Import now creates or updates the PMB Baseline. 

 On import, if you are creating a new project in Open Plan, a PMB baseline will be 
created if the baseline has been set in the MSP project you are importing. 

 If importing to an existing Open Plan project, you have an option to update the 
PMB baseline if it exists 

 Importing now reads MSP time-phased resource details and will create multiple 
resource assignments, if needed to accurately represent the time phasing of the 
resource in MSP. 

 Importing writes the Task UID to the activity, and the Resource UID to the Resource 
when importing. This allows the data to be aligned when exporting back to the 
original files in MSP. It also improved the subsequent importing of data to the same 
OP project and resource file. 
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 Depending on whether you want to import into a new Open Plan project from 
Microsoft Project or update an existing Open Plan file, the Microsoft Project Import 
Wizard – Options page will display different options.  

 Creating a new project while importing a project from Microsoft Project, the 
available options are the following: 
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 Updating an existing project from the imported Microsoft Project data, the 
available options are the following: 

 
 If you select Store WBS to Code 1 and the project you are importing into has other 

code files attached, you can use the Field Mapping dialog to store the WBS to 
another code file by mapping it. 

 Export Enhancements: 
 Export to MSP now supports updating an existing MSP Project when you are 

exporting Status. 

 When you specify the name of the file to be exported to MS Project and it already 
exists, you are given the option to overwrite it. 

If you want to replace it or update the status in it, select Yes. You will be given 
the option to choose Create/replace or Update status only mode on the 
Options page.  

 When exporting Status, any user mapped fields will also be exported. Any new 
activities will be exported 

 Export now writes resource assignment data as MSP time-phased resources which 
provides better modeling of Open Plan offsets and periods, spread curves, and 
multiple assignments of a resource to one activity. 

 You will see this in MSP just as you see any resources there today. 

 When not using MSPRIF Compatibility, export now supports task progress based on 
the Progress Type and Progress Value fields in Open Plan. This includes: 
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 Percent Complete — we write out the activity percent complete 

 Remaining Duration — we write the remaining duration 

 Actual Dates — we write the user entered dates if they exist for in progress and 
completed activities. If the activity is progress and a required actual date is 
missing we write the planned date for that value to MSP. 

Elapsed duration and Expected finish dates are not directly translated to MSP. 
They are exported as percent completes. 

 

For more information, see the Microsoft Project Export – Options Page section of 
the Deltek Open Plan 3.5 User Guide. 

 Exporting records the Task UID and Resource UID of activities and resources that 
are exported on the Open Plan data (if they were not already known from the import).  

 When exporting to existing MSP data, the Task and Resource UIDs are used to 
lookup data for updating in MSP. 

 If activities or resources do not have current MSP UIDs, those values are stored 
after exporting which requires the OP project to be saved. 

 If OP data have UIDs and we are unable to find matching data in existing MSP 
files, the UID value is reset to Zero. We do not delete data from Open Plan that is 
not found in MSP.  

 There is a new option on the Export dialog to automatically save the Open Plan 
data to ensure any UID values updated in Open Plan are saved. 

 Export now supports an Activity filter when you are updating status in an existing 
MSP file. 

 If you are exporting Status to an existing MSP file you can choose to export a 
filtered set of activities (along with associated resource assignments) 

 New activities that meet the filter criteria will also be exported 

 Export now includes an option to maintain MSPRIF (MSPRIF was a former Add In to 
Open Plan) compatibility. This affects the following data: 

 Resource assignments are exported as they were in OP 3.4.1 as totals over the 
activity duration. 

 Activity progress is exported based on the Computed Status field and includes 
Actual Start, Actual Finish and for completed activities the Percent Complete is 
set to 100%. 

 The task duration in MSP is adjusted to match the planned dates so that MSP 
does not recalculate the exported dates. 

 Exporting resources now supports exporting resource progress when not in MSPRIF 
compatible mode. 

 When available you can choose to export resource assignment remaining 
quantities or resource assignment physical percent completes to MSP. 
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All options are stored for re-use in option groups. There is a selection at the bottom of the 
export screen to load options or specify the group name to save options.  

 
 

 

For more information, see the Database Changes section. 

Improved User Authentication and Security Features 
Open Plan 3.5 adds support for additional Windows authentication options and provides a new 
user interface to configure login options, and other security features.  

EPM Security Administrator 
To access the new Authentication Options dialog box, select a product in the products list and 
then select Authentication Options from the Tools menu. 
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This dialog box is read-only for Open Plan Desktop. All Open Plan options are configured 
through Open Plan Professional, shared by Open Plan Desktop. 

 

The Authentication Options dialog box allows you to configure how users are authenticated 
when they log in to Open Plan as well as options for audit logging. 

 

 

Refer to the “Authentication Options Dialog Box” of the EPM SA Help System for more 
information about these new settings. 

Network View Enhancements 
The enhancements for the Network view are summarized below: 

 Conditional Formatting 

You can customize the display of the activity boxes for the Network View by using the 
Conditional Formatting dialog box. 

 Activity Box Properties 

 Font settings can be individually defined for each cell. This overrides the default 
global view font. 

 Text in the fields is dynamically wrapped, without truncation of data. 

 Activity boxes can now be set to become varied in sizes or can be set to conform to a 
fixed size when wrapping text. 

 Truncation behavior can now be defined for the activity boxes.    

 Relationship Box Properties 

 Relationship Attribute box properties, such as font and text placement can be 
modified with greater control. 

 Annotation Box Properties 

 Annotation Box properties, such as font type, size, color; box border shape and color; 
and box position (vertical, horizontal, and spacing) can now be formatted. 

 Activity Box Formatting 

 Activity boxes can be configured to display in different colors and/or shapes based on 
a specified value that was set.  
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 User-defined symbols, such as symbols used in conditional formatting or attributes 
can be placed in Activity Boxes.  

 Placements 

 The vertical and horizontal spacing between activities can now be defined. 

 Display interface activities (or immediate predecessors and successors of filtered 
activities, whether they meet the set filter criteria or not) can now be shown.  

 When printing or plotting a chart, the auto-fit page functionality is now available in 
order for plots to be made to scale to fit one page. 

 A warning message displays in the event that rendering will take a long time to 
complete. A progress dialog box is also displayed while the process is running. This 
gives the user the option to cancel the process.  

 Bridge lines are clearly defined, indicating that a particular crossover is not related to 
the path being crossed. 

 Logic lines are displayed with minimal crossovers. 

 Screen rendering now only takes less than 5 seconds to complete. 

 Time Scale 

 Box sizes can be made to display in a uniform size or based on the duration, whether 
Time Scaling is enabled or not. 

 Time Scale formatting can be set, such as size, shape, color, and line placement. 
This is similar to Reporting Calendars in GANTT views. 

 y-axis page height can be shortened by specifying the height of PERT boxes. The 
user-defined box height is constant for all boxes. 

 Other  

 Activity boxes are retained and displayed properly, without splitting and crossing 
page boundaries. 

 Splitting Activities across page breaks. Accept or Reject individual activities. Accept 
or Reject ‘All’. (Needs more information) 

Improvements to the Error Messages on Calculated Fields 
Error messages when defining calculated fields have been improved in the following dialog 
boxes: 

 Calculated Field Expression  

 Filter Expression 

 User Defined Validation 

Aside from the enhanced error message, the text being referenced is also be highlighted in the 
Expression: field. 

Graphical Indicator for Click to Sort 
When Click to Sort is enabled, a small arrow is now displayed when you click the column 
heading of a view, displaying the direction of the sort.  
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This arrow only shows in display mode, not in Print Preview mode.  

The status bar also displays the sort information that was applied. 

  

Display Field Names When Hovering Over Column Header 
When you hover over a column header, the tooltip shows the column header name. Previously, 
you had to double-click the field to launch the Edit dialog box in order to see the information such 
as Table Name, Field Name, Title, etc. 

This is particularly useful when you have renamed the column in the view and want to find the 
source field.  

Expanded Range of Color Choices in Views 
You are now able to select colors beyond the existing 64 color choices and apply this to menus, 
buttons, dialog boxes, backgrounds, column headers, etc. You can also backup and restore the 
view to another environment, retaining the colors previously selected.    

Owner Delegate Role 
Open Plan now includes a new built in role named OWNER_DELEGATE. The owner delegate 
role allows the owner of an item to share the right to modify the access control settings of an item 
with trusted users or groups.in an organization.  

 

Refer to the Define Group Profiles Overview of the EPM SA Help System for more information 
about the new role. 

OLE Automation Enhancements  
Open Plan reports have been improved and view functionality has been made available through 
OLE Automation. The following lists the improvements made on the reports: 

 Open Plan Application Level changes: 

o The printer to be used for the current Open Plan sessions can be set. 

o The page orientation and paper size to be used for the current Open Plan 
sessions can be set 

 View Level changes: 

 Margins can be specified to be used in printing. 

 Expand All or Collapse All can be initiated for the corresponding Open Plan view. 

 A .JPG file of the snapshot of the view can be created.Table-related notes can be 
specified to be printed with the view. 
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 Line numbers can be printed out. 

 Colors for column headings can be printed. You can also specify if columns are to be 
padded out to fill a printed page. 

 The ExpandAll method was added to the OLE API so that users can expand views 
through OLE. 

 For Barchart Views: 

 The legend can be printed anywhere in the printed output, depending on which 
location you specify. 

 The spreadsheet view can be included in the printed output. 

 The printed output can be made to fit a restricted number of horizontal pages. 

 The resource histogram can be included in the printout. 

 How the date range is to be calculated can be specified. 

o The autoscale range with custom dates can be set. 

o Custom dates for the print range can be specified. 

 How the date scale should be display can be set: 

o Fixed time units or reporting calendar divisions that determine how the 
date axis will be set up can be specified. 

o The number of axes to be displayed can be specified. 

Performance Improvements 
Performance improvements have been made in the following areas: 

 Backup / Restore 

 Save / Save As 

 Opening Projects that contain foreign relationships 

Displaying Selected Baseline Name 
A new field has been made available on the Activity table, named Source Baseline. Whenever the 
Baseline Start and Finish fields on the activity are set, Open Plan also stores the name of the 
baseline from which they were set in the new field.  

 

For more information, see the Open Plan Online Help. 
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Software Issues Resolved 

Descriptions of Software Issues 
You will notice that the descriptions of some software defects contain extra information, including 
ways to work around the defects. For the most part, these issues were addressed before this 
release through hot fixes, and the additional information was developed to help you decide 
whether or not you needed to install the hot fixes. 

When you install this release, you must install all fixes in the release; you cannot choose to install 
some and not others. Nevertheless, this additional information has been included in case you 
instituted some of the workarounds and can now stop using them, or you simply want more 
background information about the defect repairs.  

Deltek Defect Tracking Number: 437445 

Description: Shortcut keys (Link/Unlink Activities: Ctrl+F2, Schedule Driver Analysis: Ctrl+F3, 
and Trace Logic: Ctrl+F4) were added to the following views: 

 Activity Spreadsheet View 

 Activity Multi-Table Spreadsheet View 

 Barchart View 

 Network View 

 Tornado View 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: Use the menu options.  

Additional Notes: None. 

Files Updated  

OP30L409.dll 

  

Deltek Defect Tracking Number: 466770 

Description: Open Plan 3.4.0.1294 backup restored to Open Plan 3.4.0.1294 and had IDs 
Unavailable on some Code Files. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: Use the backup option 'Create Open Plan 3.3 compatible backup' 
when creating the backup. 

Additional Notes: None. 

Files Updated:  

 

Deltek Defect Tracking Number: 476353  
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Description: Backup/Restore now supports symbols. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  

  

  

Deltek Defect Tracking Number: 472205 

Description: UN/CEFACT export of activities supports risk values when present. A second 
Export script has been provided for customers who want or need to export schedule risk 
information.  

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None.  

Additional Notes: While these are optional elements, schedule risk analysis has become a 
standard requirement of contracts. The IPMR Did and UN/CEFACT schema provide options on 
how to export this data. 

BestCaseDurationMeasure DurationMeasure Used when a three point 
remaining duration estimate is 
required for the task (monte 
carlo simulation) or for a user 
determined best case duration. 
Enter the task's best case 
duration along with the duration 
measure attribute such as 
"DAY". 

MostLikelyDurationMeasure DurationMeasure Used when a three point 
remaining duration estimate is 
required for the task (monte 
carlo simulation) or for a user 
determined most likely duration. 
Enter the task's most likely 
duration along with the duration 
measure attribute such as 
"DAY". 

WorstCaseDurationMeasure DurationMeasure Used when a three point 
remaining duration estimate is 
required for the task (monte 
carlo simulation) or for a user 
determined worst case duration. 
Enter the task's worst case 
duration along with the duration 
measure attribute such as 
"DAY". 
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Files Updated  

IPMRFormat6r.xfr 

  

Deltek Defect Tracking Number: 472119 

Description: When exporting MSP files, extended ASCII characters for filter results were 
exported when mapped to a Text field. (æ for True and É for False) 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: Create a calculated field that converts the results to text and export 
this calculated field instead. For example, iif(<FilterName> = [TRUE], 'TRUE', 'FALSE') 

Additional Notes: None. 

Files Updated:  

 

Deltek Defect Tracking Number: 478486 

Description: When you updated an existing Open Plan project using MSP Import, field 
mappings from MSP fields to code fields other than C1 were not handled properly. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  

 

Deltek Defect Tracking Number: 437726 

Description: The following options were not displayed in Tornado view: 

 Display Line Numbers in Spreadsheet 

 Suppress Color in Spreadsheet Headings  

 Expand Columns to Fill Page 

This issue is encountered both in SQL and Oracle databases 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  

 

Deltek Defect Tracking Number: 437451 

Description: The following shortcut menu items were missing: 

 Project » Time Analysis showed Ctrl+F9  
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 Project » Resource Schedule - did not show Ctrl+R  

 Project » Risk Analysis - did not show Ctrl+K  

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: Ctrl+Shift+R displays the Resource Scheduling dialog and Ctrl+Shift+K 
displays the Risk Analysis dialog. 

Files Updated  

OP30L409.dll 

Files Updated:  

 

Deltek Defect Tracking Number: 434606 

Description: PMC Baseline Update did not proceed correctly, resulting to the following:  

 Baseline dates were moved to the early dates, if not in progress 

 If in progress, the baseline finish date is extended to the early finish date 

 The existing budget after the status date is moved to span the new Baseline dates 

 The change is applied as an adjusting entry 

 There are no history budget changes 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None  

Additional Notes: None. 

Files Updated  

OPP30DLL.dll 

OPP30.exe 

OPD30.exe 

PROCESSDLL2.dll 

Deltek Defect Tracking Number: 461461 

Description: In Open Plan 3.3 SP2 Cumulative Update 19, a new system option named 
_REPLACEBASELINEBUDGETWITHACTUALS was added to disable the default behavior 
where Actuals are used to populate Baseline Usage information for complete and in-progress 
tasks. The option was not honored for baselines based on schedule dates when the option is 
disabled. 

Customers Impacted: This defect affects all Open Plan users. 

Workaround Before Fix: None. 

Additional Notes: The system option can be found in the System Preferences under Tools » 
Tools » Options.  Select the Advanced tab and then click the Defaults button. The behavior is 
enabled by setting the new preference to a value of 0 (zero), effectively disabling the use of 
Actuals to update baseline usage. The existing behavior can be re-enabled by removing the 
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preference or setting the value to 1. 

Files Updated  

OPP30DLL.dll 

  

Deltek Defect Tracking Number: 465366 

Description: PMC Baseline Update process did not spread Baseline Resource Usage as 
expected on In-Progress Activities.  

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None.  

Additional Notes: None. 

Files Updated  

OPP30DLL.dll 

PROCESSDLL2.dll 

  

Deltek Defect Tracking Number: 441396 

Description: Duplicate warning messages were generated that validates the Actual Finish Date. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  

 

  

Deltek Defect Tracking Number: 3292 

Description: No calendar set was specified on the subsection summary row resulting to 
incorrect values. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: Use the calculated field expression with the calendar set you want to 
use: (efdate,bfdate,iif(ACT_ID NOT_EMPTY,CLH_ID,"")). 

Additional Notes: None. 

Files Updated:  

 

  

Deltek Defect Tracking Number: 160731 
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Description: Column header was changed to its field name after you edited the values in the 
Edit Column dialog box. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: Re-edit the information in the Edit Column dialog box. 

Additional Notes: None. 

Files Updated:  

 

Deltek Defect Tracking Number: 438744 

Description: FAIL_EVALUATE() did not work for C1.DESCRIPTION. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  

 

Deltek Defect Tracking Number: 437441 

Description: Open Plan Explorer » Users folder also showed Cobra and PMC users, aside 
from Open Plan users that logged in to the application. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  

 

 

Deltek Defect Tracking Number: 476952 

Description: In Network View Placement settings, only some of the changes made were saved.  

Customers Impacted: This defect affects all Open Plan users. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  

 

 

Deltek Defect Tracking Number: 437463 
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Description: Ctrl+C functionality did not work when you clicked to select a cell in Excel. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: Select the text in the edit window above the spreadsheet to copy the 
text. 

Additional Notes: None. 

Files Updated:  

 

Deltek Defect Tracking Number: 186743 

Description: The Change Access Control dialog box listed all projects when the list is filtered to 
only show Project Templates. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  

OPP30.exe
 

 
  

Deltek Defect Tracking Number: 484340 

Description: The message, "(31705) Duration may not be negative." was shown multiple times 
when you entered negative TimePhase resource assignments in Activity Details >> Resources 
dialog box.  

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  

OPP30.exe 

OPD30.exe 

 

  

Deltek Defect Tracking Number: 490100 

Description: Microsoft Project did not correctly set actual dates and % complete during export. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  
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Deltek Defect Tracking Number: 487748  

Description: When using MSP 2013, Actual Start Dates did not display unless the % Complete 
field has been set to a value > 0 during MSP export. 

Customers Impacted: This defect affects all Open Plan users.  

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  
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Database Changes 
This section includes the changes made to the database for this release. 

New Tables 

Table Name Description 

WST_CFG Configuration Options 

Deleted Tables 

Table Name 

None 

New Columns Added 

Table Name Column name DataType 

OPP_PRJ MSP_GROUP_OPTS_ID VARCHAR2(60) 

OPP_PRJ MSP_IMPEXP_OPTS  

OPP_ACT SOURCE_BASELINE NVARCHAR(10) 

Changes to Existing Columns 

Table Name Column Name New DataType Old DataType 

None None None None 



 

 

 

Deltek is the leading global provider of enterprise software and information solutions for professional 
services firms, government contractors, and government agencies. For decades, we have delivered 
actionable insight that empowers our customers to unlock their business potential. Over 14,000 
organizations and 1.8 million users in approximately 80 countries around the world rely on Deltek to 
research and identify opportunities, win new business, optimize resource, streamline operations, and deliver 
more profitable projects. Deltek – Know more. Do more.®  

deltek.com 
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